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personal computer running Microsoft Windows 
3.1x or Windows 95.  Remote control software 
is normally shipped with the FM Pro but is also 
available from any Aphex dealer and it can be 
downloaded from the Internet web site at http://
www.aphexsys.com.  The computer may be con-
nected to the FM Pro directly by an RS232 cable 
or by a telephone modem.  

11.1 Hardware Requirements
1. 386-33 or higher class personal computer.

2. Windows 3.1, 3.11, 9x, 2000 operating system

3. Minimum 4MB RAM

4. 2.5MB Hard Disk Space for program files 

5. 3.5”-1.44MB Floppy Drive

6. One available serial port (com1, 2, 3, or 4)

7. 800x600 or better Color or Monochrome 
Display

8. Pointing device (mouse, trackball, etc.)

9. Two modems-- one for the P.C. and one for 
the FM Pro (no modems needed for port-direct 
connection).

11.2 Software Installation
We constantly strive to improve our software. 
Please take into account any changes that may be 
implemented in newer software versions and alter 
your interpretation of these instructions accord-
ingly. Check the 2020 web site at www.aphex.com 
for new release information. 

The FM Pro comes ready for remote operation, so 
you will not be required to install software into 
the unit itself. You need only to install the remote 
control software onto your own computer. 

To begin installation, insert Install diskette 1 
and, from the run menu, enter a:\setup then 
click OK.  If your floppy drive letter is other 
than a:\ then simply substitute the correct drive 
letter, i.e., b:\setup.

The setup program will automatically install all 
required components into your system and create a 

11.0 Remote Operation
directory named C:\FMPRO to contain the program 
files. You will be instructed to insert additional 
diskettes as needed. 

11.3 Communications Cable Hook-Ups
You can connect your computer to the FM Pro 
through a direct RS232 cable or a pair of modems. 
The serial cable will differ depending upon the type 
of connection

11.3.1 Direct Connection
The direct connection uses a “null modem” serial 
communications cable to connect your PC to the 
FM pro. Commercially available null modem cables 
come with various configurations of male and 
female connectors. The FM Pro wants a 9-pin 
female cable end while your PC wants either a 
9-pin or 25-pin female cable end. Simply obtain or 
construct the proper cable and use gender changers, 
if necessary. If you make your own cable, then 
follow the pinouts of figure 11-1 or 11-2.

11.3.2 Modem Connections
11.3.2.1 Modem To FM Pro
For remote control through telephone lines, an 
external modem must be connected to the serial 
port of the FM Pro.  Most external modems contain 

Figure 11-1 9-Pin To 9-Pin Null Modem Cable

Figure 11-2 9-Pin To 25-Pin Null Modem Cable
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you will need to obtain a standard modem cable, 
not a “null modem” cable as described above, with 
the proper connectors attached. If off-the-shelf 
cables are unavailable, you may may construct the 
cable according to the wiring diagram of figure 
11-3.

11.3.2.2 PC To Modem
You may use either an internal or an external 
modem with your PC.  If using an external modem, 
you’ll need a standard serial cable from the PC 
serial port to the modem.  You must not use a null 
modem cable.  Your PC can have either a 25-pin 
or 9-pin serial port, therefore you need to get the 
appropriate cable and possibly an adapter.  For 
a 25-pin serial port the proper cable contains a 

25-pin male and a 25-pin female connector.  For a 
9-pin serial port the proper cable contains a 25-pin 
male and a 9-pin female connector.  If off-the-shelf 
cables are not available, you can make the cable 
according to figure 11-4.

11.4 Operation By Modem
11.4.1 Usable Modem Types
Generally, any Hayes-compatible modem capable 
of 9600 baud or greater should work. Newer 
V32.bis modems will connect at the highest speed 
the line quality supports, usually 14,400 to 33,600 
baud, while older fixed rate modems will just lock 
up at their specified baud. The serial communica-
tions of the FM Pro and the PC are set to 9600 
and need only to see support for 9600 baud from 
the modems. The newer, faster modems usually 
offer better performance because of improved error 
handling. 

11.4.2 Modem In The Windows Operating 
System
Even though the Aphex remote software runs under 
Windows 3.1x or Windows 95, you do not have 
to configure the modem for the Windows environ-
ment.  We take care of all modem control through 
the software. If your PC modem is already config-
ured with windows drivers that is not a problem. 
You only need to check which com port it is 
attached to.  If the modem is internal, usually it 
will be configured to Com4 but you should double 
check your modem configuration so you will select 
the correct port in the remote program.

11.4.3 Modem Installation Procedure
When setting up the FM Pro for a modem connec-
tion, please follow these steps to properly initialize 
and activate the modem.

1. Power down the FM Pro.
2. Connect the FM Pro to the modem by a standard 
(not a ‘null modem’) cable.
3. Power up the FM Pro and the modem.
4. In the remote link menu, set the remote link 
“OFF” then set the link type to “modem”.  You 
can only set the link type when the remote link is 
off. Lastly, set the remote link to “ON”. The link 
status should first show “wait” and then “M-OK” 
indicating that the modem is initialized. The FM 
pro will force the correct modem settings regardless 
of how the dip switches may be set on the modem. 

Figure 11-3 Modem to FM Pro Serial Cable

Figure 11-4 Modem to PC Cables
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modem is not connected! This will cause the 
FM pro to lock up it’s front panel for about 
20 seconds.

The FM pro will continuously check if the modem 
is still connected.  In case of power interruptions, 
the FM Pro will automatically recover itself and 
re-initialize the modem. 

11.4.4 Troubleshooting The Modem
If you have problems connecting to the modem, 
here is an easy way to check if the units are 
communicating properly.  

1. Power-off the modem.
2. Turn off the modem’s auto answer feature using 
the modem’s dip switches or jumpers. If using a 
US Robotics modem, flip switch #5 “DOWN” to 
set auto answer off.
3. Set remote link “OFF” and link type to 
“modem”.
4. Power-on the modem. The AA (auto answer) 
light must be off.
5. Set remote link “ON” and watch the modem’s 
AA light.  When you turn the remote link on, the 
AA light must come on. If the light comes on, that 
proves the FM Pro is commanding the modem and 
the unit should work properly.  If the modem’s AA 
light does not come on, then either the modem or 
the cable is defective. 

11.4.5 Compatibility Issues
We have experienced problems supporting some 
manufacturer’s modems. Our lab has verified that 
the 33.6K baud modems by US Robotics, Best 
Data, and Supra will work with the FM Pro. If 
you have another brand of modem and you find it 
works well with the FM Pro, we would like 
you tell us so we may add it our list of known 
modems. As time goes by, we will post additional 
modem information on the Internet at our web site 
www.aphex.com. 

11.5 PC Remote Control Main Form
When you first start the program you will see the 
Main Form of figure 11-5.  This form links you 
to all the program functions such as the control 
panels, presets, and communications. The various 
indicators on this form show you how well the 
data is being passed between the FM Pro and 
your PC. 

11.5.1 Link Status
This indicator shows you if your link status is 
working, and whether by direct line or modem.  
The operating condition is indicated in green. 

Note: The FM Pro must have the Remote 
Interface feature turned on and set to the correct 
mode (modem or direct) or you cannot establish 
a remote link.

11.5.2 Transmit Speed
This shows how efficiently the data is being carried 
from your PC to the FM Pro. Data is not always 
being transmitted, so this indicator may be blank or 
at a low value until you begin moving settings.

11.5.3 Receive Speed
Your PC normally receives a continuing stream of 
meter data. This indicator allows you to see how 
efficiently the receive data is streaming through the 
link. If your modem is operating on a bad phone 
line, you may see this value fall low and the meters 
on the panels may become erratic.

Figure 11-5 Main Form

Figure 11-6 Establishing a Connection

1. Select Com Port

2. Select
Connection
Type
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To begin direct communications, open the “Com” 
menu and select the com port you will be using. 
Next, select “Port Direct” out of the “Connect” 
choices. If the FM pro is properly connected to 
your PC, then you will immediately receive a 
series of messages indicating the success of the 
connection.

Note: You must set the remote link status on the 
FM Pro to “DIRECT” (not “modem”) to allow 
direct linking. 

If there is a password in the FM Pro, you will 
be shown a dialog box requiring the password to 
be entered. Once the password is correctly entered 
you’ll be able to continue. 

11.6.1 A Note On Day Parting
If day parting by the FM Pro is currently in effect 
at the time you are logging into the remote link, 
you will get the dialog box of figure 11-7. This box 
allows you to decide if you want to turn off the 
day parting, leave it on while you work, or put it 
at rest. When at rest, the day parting is temporarily 
shut off while you are connected, but automatically 
turns back on when you disconnect the remote 
link. 

11.7 Modem Linking
Follow the same procedures as 11.6 above, but 
select “Modem” instead of “Port Direct”.  A dialog 
box will open up indicating the modem is being 
initialized. When the modem initializes, you will 
be then be given an input box to enter the telephone 
number which must be dialed.  While the number 
is being dialed, you can abort by pressing “cancel” 
on the dialing message box. If a password is 
in effect, you will be asked to enter the log-in 
password.

Note: You must set the remote link status on 
the FM Pro to “MODEM” (not “direct”) to 
allow modem linking.  To avoid trouble, please 
read the information about modem hook-ups 
included later in this section.

11.8 Using The Remote Control Panel
From the Tools menu, select Controls.  This opens 
up the tabbed control of figure 11-8, giving you 
access to all the FM Pro programmable functions. 
Each major processing group can be reached by 
clicking the appropriate choice tab. To adjust any 
variable control, simply put the pointer on the 
handle, hold down the left mouse button, and drag 
the mouse pointer. 

11.9 Dealing With Presets
There are several ways you can deal with presets 
in the remote link.  You can import and export 
presets to and from data files and you can recall 
or save presets in the FM Pro memory.  Recalling 
and saving are similar to what you can do on the 
FM Pro front panel itself.  Import and export are 
additional capabilities given to you by the remote 
software program. You can upload one or more 
presets to a file on your PC or floppy disk for 
transport to other FM Pro units, and you can 
download presets from such a file. Export files 
contain the extension *.fmd. 

11.9.1 Recall Preset
From the Tools menu, select Recall Preset. This 
opens the recall form which proceeds to download 
all the presets currently in the FM Pro’s memory 
including the factory and user presets. Simply select 
the preset you want from the list and click recall.

11.9.2 Save Preset
From the Tools menu, select Save Preset. A panel 
will open showing you all the user presets currently 
in the FM Pro and allowing you to chose one 

Figure 11-7 Day Parting Dialog Box

Figure 11-8 Remote Control Panel
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the location, click Save.  The preset editor opens 
and allows you to name the preset, and add other 
information.  When you again click Save the 
information will be uploaded to the FM Pro’s 
presets memory.

11.10 The View Menu
This menu gives you several useful choices such 
as the current on-air preset, day parting status, and 
unit info from the FM Pro.  You can readily find 
out what software version is running on the FM 
Pro through this menu. 
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